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PRESIDENT’S MESSAGE  

 
 hanks to the fantastic help and donations we got from our members, the Spring Sale was a real success.  
I cannot tell you how impressed I was with the cooperation and teamwork during the sale.  We grossed 
$577 as compared to $397 at last Fall’s sale.  Our net for both sales was $150 less, which is the mandatory 
assessment fee we pay the Shepard Garden and Arts Center.  In turn, they do excellent advertising to bring 
in customers.  
 Kudos go to the following members for generously donating their time and energy to this success.  
They are Dorothy Sorenson, Barbara Jones, Bob Hubbell, Carol Jordan, Hope and Willis Price, Laurie 
Friedman, Bea Jones, James Cehand, and B. J. Ueltsen.  Their work made it possible for me to only be 
there for three shifts out of six. 
 A big thank you goes to another person, whose work brought in over 1/3 of the revenue.  I’m sure 
you might have guessed it was Truman Holtzclaw.  He gave us dozens of prints to sell and had matted 
them as well as protected them in sleeves.  There were many words of praise about his work from 
customers as well as those about Barbara Jones’s photo cards.  As a reminder, you won’t want to miss 
Truman’s show at the Viewpoint Gallery on May 13th.   
 Other donations came from Dorothy Sorenson, Ron and Sandy Parker, Bob Hubbell, Carol Jordan, 
Hope and Willis Price, Bob Hubbell, and yours truly. 
 
Photography Club Trends 
 From what I hear, many camera clubs in the surrounding area are experiencing a drop in membership 
and we are no exception.  I would like you all to put on your thinking caps and your energy to soliciting 
more new members or bringing back former members.  Sandy Parker has been doing a great job with the 
membership, so this does not reflect on her exceptional performance.  Rather, it reflects a trend as we 
move from film to digital.   
 With many people not prepared to make the change, we need to encourage them to learn new skills 
and give them workshops like Bob Hubbell is doing. We also need your ideas and help in talking to your 
friends who are interested in photography.  Please get involved in this effort and bring friends to our 
meetings.  Also, take courses and read books to enhance your own learning in the digital area of 
photography.  Happy Learning! 
 
Membership Vote at the April General Meeting
 I will be asking SCC members to vote on the purchase of a spare bulb for a digital projector we are 
borrowing to use in our Digital Imaging Meetings. In exchange for the use of the projector, we need to 
spend $200-$300 for a replacement bulb for the projector's owner.  In the future, we will need to purchase 
a digital projector, but we would also need a spare bulb for one we would purchase.  If you would like to 
discuss this option at the April Meeting, you will have the opportunity to do this before we put the 
proposal up for a vote.         
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           aren Wyatt, from Auburn judged our March Color Slide Division.  We thank her fo
Our next meeting will be May 9th.  Judge will be announced in May Gammagram. Karen g
Donna Sturla, Joyce Boyer, BJ Ueltzen, Ron Parker, & Willis Price  
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*Bring two make-up slides in May 
 
BJ Ueltzen took Slide of The Month with “Chelatna Lake 
Pier”.  Congrats BJ.  It is beautiful. Willis Price’s was 
Karen’s favorite with “Potato Racer”. 
 
THANKS TO ALL THE WORKERS 

Class AA    
Joyce Boyer    45  
Joan D. Scheer  44  
Donna Sturla  43  
Ken Bosanko    42      
Betty Olsen         9 *    

Top Ten 
Willis Price        46 
Truman Holtzclaw    44 
Gail Parris                44 
Jim Cehand         43 
Laurie Friedman      43 
Carol Jordan             43 
Diane Hovey      41 
Susan Nielson    25* 
Julius Fava                22* 
Margaret Fava    22* 

Class AAA    
Peggy Gidding  45    
Ron Parker   45     
BJ Ueltzen   44     
Marcia Sydor  22*     
Gail Foley   21* 

     Jim Cehand projected, Willis Price focused.  Melba Martin, Don Martin & Gail Foley re
Martin, Chuck Pivetti, Ken Bosanko and Willis Price set-up and took down the equipment
thanks to Chuck Pivetti for scanning BJ’s Slide of the Month and sending it in for the Gam
for making a print of it to display at Camera Arts.  Refreshments were furnished by Marlen
Gail Parris. Yum-m. And of course Carol Jordan did her usual wonderful job of hostessing
refreshment table. Thank you one and all 
     Before our meeting on the 2nd Tuesday, some of our members and friends gather for di
comradery.  We have a good time.  If you plan to attend, please notify me prior to the day 
make reservations.           
 

TRAVEL & NATUR
 
 
           ur next competition will be on Thursday, April 6th, with Tom Myers judging.  New c
welcome to join us (for Travel Sequences and/or Singles, and Nature), bringing make-up s
February.  As you can see, Truman is starting off strong, but come join and give him a run
(not that I want to stress competition….). 
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ELECTRONIC DIVISION 
Chuck Pivetti  

O 
 
 
 ur next meeting will be on April 11. The judge will be Shelly Thorene, another artist from Viewpoint 

Gallery. Please submit three images each for the April competition. Our fun assignment category for April 
is “Right Stuff.”  Don’t forget the Spaghetti Factory before the meeting. Let me know if you will be joining 
us (916) 359-7049, cpivetti@winfirst.com. 

 
Something To Think About 

What would you think of splitting the competitors into two classes by putting the competitors with 80 
or more accumulated points into an “AA” Class and the remainder into an “A” Class. We can discuss this 
at the April meeting before the competition begins, and if you agree to the split, we can institute it 
immediately.  

 
Formatting 

Below is a condensed version of the emailed instructions for formatting digital entries. The full version 
was emailed to all competitors in March. After you have finished cropping, adjusting, enhancing or 
whatever and your image is all ready to submit, please do the following: 
  

 Under the “Edit” menu, select “Convert to Profile.”  
 The dialog box will open.  
 Select “sRGB IEC 1966-2.1” for profile if it is not already selected.  
 Click “OK.” 

 Under the “Image” menu, select “Image Size” (“Image Resize” in Elements).  
 The dialog box will open.  
 Make sure the “Resample Image” and “Constrain Proportions” boxes are checked. 

 Enter 100 pixels/inch.  
 Enter 10 inches for width. If this causes the height to exceed 7.5 inches, set the height to 7.5 

inches and the width will reset itself.  
 Click “OK.” 

 Under the “File” menu, select “Save As”. 
 The dialog box will open. If it is a small version, click the little triangle at the end of 

the  “Save As” box, and the window should extend to show the path to your file 
folder.  

 In the “Save As” box, type your last name followed by your first initial followed by 
the title of your image. The file extension, “.jpg” is automatic. (DoeJFlower.jpg) 

 (Mac users should select “Always” in the “Append File Extension” box in 
“Photoshop Preferences”/”File Handling.”)  

 In the folder box select the location in your computer where you want to save your file.  
 In the “Format” box, select “JPEG.” (If “JPEG” is not one of the options in the pull-down list, 

you may have to change “Image”/”Mode” to “8 Bits/Channel.”)  
 Make sure that the box in front of “Embed Color Profile: sRGB IEC1966-2.1” is checked and 

click “Save”.  
 The dialog box will open. In the “Quality” box. Enter “8”.  
 Click “OK”.  

 
 

 

mailto:cpivetti@winfirst.com


P N 
l   

      he second print workshop was another success! It covered selections in Photosho
and the use of full dynamic range of your printer by Ron Parker. If you have not attend
workshops, you still have a chance to come out to the next one in July. Art Schroder ca
the club members about the Annual West Sac Photo Contest as well. See Announceme
more information on this contest. Our first prints competition in 2006 will be May 23. 
 

 

 

Bob Hubbell educating & 
entertaining 

 

 

 

 

 
Art Schroder with 2005 
Contest Winning Photo 
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PHOTO OPPORTUNITIES, WORKSHO

Photo Opportunities 
 The foothills beckon! This is wildflower season and you’ll find them in the foothills
finding them is Wildflower Walks and Roads of the Sierra Gold Country, by Toni Fauv
Bonanza Press, 1998). But don’t forget the other attractions in the Mother Lode. Sutter
Amador City, Volcano, and Fiddletown. Get off the main drag. Especially look for the 
Bee (03/05) recommends Bunker Hill Rd: from Amador City, go east on Water St and 
St or farther out on Turner Rd. This leads you to a network of roads, including Turner,
Fremont Mine and New Chicago Quartz Mountain roads. Look for flowers, graveyards
stone fences. In Jackson, be sure to visit the Serbian Orthodox Church on Jackson Gat
from town. The story I’ve heard is that even Ansel had trouble getting a good shot! Go
Plymouth to the Shenandoah Valley for winery vistas (and tasting unless you’re the des
photographer). Continue around to Fiddletown. While you’re there visit the Chew Kee
4pm, Saturdays only.  
 The vernal pools at Mather, Phoenix Park and the preserve off of Highway 113 sou
blooming. And this is the time to visit Bear Valley, northwest of Williams. Take Highw
Woodland to get there, watch for redbud, etc., along the way. Call me if you need direc
these places.  
 
Contest 
The West Sacramento Days in May Photo Contest is back! The goal: Capture extraordi
everyday life in West Sacramento. Photos must be taken between May 1st and 15th. Dea
May 15th. There are five categories for entries, but only one photograph per photograph
For more information, please visit www.ci.west-sacramento.ca.us or call (916) 617-4500
 

RINT DIVISIO
Bob Hubbel

p by Bob Hubbell 
T    

ing one of these 
me out to inform 
nts section for 
 

on Parker with 
Step Chart 

 

PS, & SHOWS 
Bob Hubbell  

. The best guide for 
er (Comstock 
 Creek, Jackson, 
churches. The Sac 
then left on School 
 Bunker Hill, 
, old structures, 
e Rd, going north 
 east from 
ignated 
 store, open 12-

th of Dixon will be 
ay 16 out of 
tions to any of 

nary images of 
dline for entries are 
er will be accepted. 
. 

http://www.ci.west-sacramento.ca.us/


Show  
The Sac State Library Gallery will show photos from the CA State Library collection, Mar 3-Jun 24. 
Gallery hours: 10-5, Tue thru Sat. Parking is easier on Saturdays. 
 
Workshops 
Join Jim Miotke, author of The BetterPhoto Guide to Digital Photography, for a fun and interactive talk 
about digital picture taking! Jim will be giving practical, easy-to-follow advice on improving technique and 
making the most of your digital camera. Jim will also be signing copies of The BetterPhoto Guide to 
Digital Photography, his latest photography how-to book!  
 
Jim Miotke is the President and founder of BetterPhoto.com™ the worldwide leader in online 
photography education. An online instructor for one of the site's courses on digital photography, Jim is 
also a professional photographer with more than twenty years' experience.  
 
So, come join Jim and learn more about digital photography in this fun and inspiring talk! Looking forward 
to seeing you there!

 
Thursday, April 6, 2006  
6:30 p.m.  
Elk Grove Library  
8962 Elk Grove Blvd.  
Elk Grove, CA 95624  
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Heather Cline 
   Editors Notes 

H 
      

          elp make the Gammagram more dynamic - Please send stories, travel information, contests, 
regional events, photo opportunities, websites, and of course images to 
hcline_photography@hotmail.com.  
Photo Needs: Slide of the night   Members, Meetings, & Events  Nature  Travel  Seasonal 
 
 

Sierra Camera Club 
Visitors are welcome 

A  
            t Sierra Camera Club, people of all ages and backgrounds get together to share a passion for all 
kinds of photography. Our divisions have member competitions and workshops. Visitors are welcome to 
come and enjoy the photography any time! The monthly club business meeting precedes the Color and 
Electronics Imaging division meetings. All Sierra Camera Club divisions meet at the Shepard Garden & 
Arts Center, 3330 McKinley Blvd., Sacramento at 7:30 pm.  
 

Club Divisions 
Color 
Hope Price 916.487.4088   Meets: Second Tuesday in Jan, Mar, May, Jul, Sep, & Nov 
Nature* & travel 
Laurie Freedman 530.758.9668  Meets: First Thursday in Feb, Apr, May, Jun, Sep, & Nov 
prints 
Bob Hubbell 916.383.5188        Meets: Fourth Tuesday in Jan, Mar, May, Jul, Sep, & Nov 
Electronic 
Chuck Pivetti 916.359.7049  Meets: Second Tuesday in Jan, Feb, Apr, Jun, Aug, & Oct 
*Laurie Freedman is managing the Nature division during Pat Malott’s absence. 
 

Calendar 
April 

 

April 
 

 

  1 

2 

 

3 4 5 6 

Nature/Travel 

Meeting 

7 8 

9 

 

10 11 

Electronic/Club 

Meeting 

12 13 14 15 

16 

 

17 18 

Board Meeting 

19 20 21 22 

23 

 

30 

24 25 26 27 28 29 
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Sierra Camera Club Field Trips 
 

 
We have already experienced a couple of successful field 
trips this year so let’s plan some more! Below is an idea 

list of possible photo destinations. 
 

Please review this list then add to it. It’s so easy. Just 
think of your favorite places to photograph and write the 

       following information on the attached sheet. 

Name   Location   Approximate distance  Best season to photograph if applicable 
 

Trips cannot take place without someone to plan them. This doesn’t mean you have to be a world 
renowned photographer or a professional planner, you just have to be familiar with the location and be 
willing to coordinate the meeting date. Please don’t wait for someone else to do this – our club is only as 
strong as the members make it! 

 Downtown Sac, Capital, Cathedral, K Street, Victorians, Cemetery. . .  
 Old Sac (Night Shoot) Street lighting, People, River boats, Tower bridge, Pyramid Bldg, Trains, Docks 
 Sacramento Zoo 
 UC Davis Arboretum 
 Sac River towns, Freeport, Clarksburg, Hood, Courtland, Locke, Bridges, Orchards, etc…  
 Consumnes River Preserve  
 American River, North and Middle Fork Confluence; near Foresthill  
 Fiddletown, Historic buildings 
 Walker Ridge, Wildflowers 
 Malakoff Diggins State Park 
 Jackson, Sutter Creek, Motherload area: historic towns, churches, cemeteries, and main streets…  
 Volcano 
 Gray Lodge Wildlife Area  
 Spenceville Wildlife Area 
 Sutter National Wildlife Refuge 
 Sacramento National Wildlife Refuge 
 Napa Valley, Vinyards, Mustard, Balloons, etc  
 San Francisico: Golden Gate Pk, Fort Pt, Marin Headlands, Bonita Pt Lighthouse, Zoo 
 Point Reyes Lighthouse & recreation area, birding, elk, wildflowers in March  
 Mono Lake  
 Bodie State Historic Park  
 Bowling Ball Beach, Gualala & Pt Arena Light, Pt Arena 
 Yosemite  
 Bear Valley  
 Lake Tahoe 
 Vernal Pools (Sacramento)  
 Dixon Lambtown event 
 Historic Bldg in Woodland 
 Jazz Festival 
 Pioneer Days 

 
 
 



Annual Membership & Newsletter Renewal 
Membership dues are due January 1 and are delinquent after January 1, 2006. Any member 
whose dues are in arrears for two months, i.e., not paid by March 1st, will be dropped from 
the membership roll after notification by the Treasurer, not included in the club 
directory, and ineligible for competition. New members, after July 1, pay half the annual 
rate.   
 
Subscription Type  Annual Dues/Initiation Fee* Total (New Member) Total (Renewing)     
      
Single Membership  $45 +     $5*        New  $50             or     Renewal  $45  

Family Membership  $70 +     $7*        New  $77             or     Renewal $70 

Juniors (Under 18)   $10 +     $2.50*    New  $12.50    or      Renewal $10 

FT Students (under 22) $22.50 +  $2.50*    New  $25.00    or      Renewal   $22.50 

Gammagram Only   $12   -      New $12        or      Renewal $12 
Subscribers are not voting members of the club 

 
Members agree to abide by the club constitution, by-laws, and competition rules. 
 

Name (Print) _____________________________________________________________________________________________________________ 

Street Address: ___________________________________________City ________________________________Zip Code _______________ 

Phone(s) (_______) _____________________  (_______) _____________________  Email  _____________________________________________ 

Signature:  __________________________________________________________  Date ______________________________________________ 

The Gammagram will be delivered to the email address listed above. If you need the newsletter mailed to you, 

please check here   

 
Please make checks payable to: Sierra Camera Club 
Mail to:  Ron Parker, Sierra Camera Club Treasurer, 1845 Barn Valley Lane, Lincoln, CA 
95648. 
 

 - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -  
 
 
Sierra Camera Club 
2462 Via Camino Avenue  
Carmichael, CA 95608 
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